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BASIC INSTRUCTIONS
Introduction
Unlike systems with an X-ray output for external devices, scanning electron microscopes (SEMs) are
not included in the devices requiring user registration set forth in the Laws Concerning the Prevention of
Radiation Hazards due to Radioisotopes and the Rules Concerning the Prevention of Ionizing Radiation
Hazards.
However, in an International Commission on Radiological Protection (ICRP) recommendation, SEMs,
as with usual TV sets, are listed as a potential source of X-rays as an unwanted byproduct.
Users must pay attention to the protection of personal health.
As a precaution, you should observe the following instructions.

(1) Use the system for the purposes and within the range of use described in the Instruction
Manual.

(2) Do not operate the system when a protection or safety cover is removed.
(3) Do not modify the system by the customer.
(4) Do not operate the system with the safety device turned off.

Safety Precautions
This system contains high-voltage circuits that may cause electric shock hazards.  Before starting
maintenance work, be sure to turn off the AC power supply.  Any maintenance work not described in
this Instruction Manual must be done by our authorized service persons.

 DANGER

★ Do not touch the areas around a DANGER or CAUTION label shown in the figure below.
★ Do not connect or disconnect a cable unless instructed by this Instruction Manual or our

technician.
★ This system is used high-voltage circuits inside.  Do not touch the inside unless instructed by our

technician.
★ Ground the system properly.  Improper grounding may result in system failure or electric shock.
★ If you have to touch the inside, turn off the power and wait for several minutes before starting work.
★ In an emergency, turn off the breaker on the power distribution panel or system and call to Elionix.
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 Important

★ Do not turn off the N2, air, and power lines while the system is in normal operation.
★ Do not give vibration to the barrel.
★ Close the specimen chamber door firmly.
★ Do not forcibly vent the vacuum section.
★ Do not touch the hand valve on the barrel unless you are maintaining the barrel.

 Caution

★ Do not let water, dust or other foreign matter flow through the N2 and air lines.
On the N2 line, use dry N2 only.

★ On a system with a turbo molecular pump, replace the battery once a year.
★ Do not load anything other than specimens for lithography or observation to the specimen

chamber.
★ Do not use radioactive materials, materials contaminated with radioactive rays, corrosive materials,

or materials containing a large amount of solvent as specimens.

*  In addition to the above, you must follow the instructions described in this manual.

Contact ELIONIX CO., LTD. Phone: 0426 (26) 0702 (Production Department)
      or
0426 (26) 0611 (Sales Department)
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SPECIFICATIONS
1 Overview

This system serves as a SEM providing, in addition to usual secondary electron images, topography- or
component-enhanced high-magnification images for non-contact measurement of fine contour of the
observed surface of the specimen.
This is an advantage of the system’s four-channel secondary electron detectors.  Each signal is
processed by the computer to provide qualitative expression of topographic profiles.
This system allows qualitative observation of very slight undulations or fine surface roughness you could
not see with conventional SEMs.
Through the Microsoft Windows-based GUI (Graphical User Interface), most operations can be done
intuitively using the mouse.

Features

1. The four secondary electron detectors provide high-resolution images from multiple directions in
three modes; Topography (TOPO), Composition (COMPO), and Conventional SEM.
You can observe image illuminated by a shadowless light source, images of fine topography and
slight undulations at low magnifications that can hardly be observed through conventional SEMs.

2. The electron probe scans the specimen surface at high speeds, eliminating the chance of
damaging the surface.  Probe current is as low as 10−12 A, allowing you to use specimens
susceptible to heat.

3. Automatic focusing, astigmatism correction, and image signal level adjustment ensure
measurement quality through simple operation.

4. Images are stored in the frame memory and displayed as still images on the high-resolution
monitor.  You can observe SEM images in a well-illuminated room.

5. The five axes (X, Y, Z, R, and T) of the specimen stage are driven by high-precision motors.
It is easy to locate a desired field of view.

6. You can observe the entire surface of specimens up to φ125 × H10 mm or φ50 × H30 mm.
7. Magnification and stage position are stored temporarily in the system.  Such information can be

called simply by pressing a button.  This function is very helpful when you lose the observation
point.

8. The resume function automatically restores the conditions of the previous measurement when you
turn on the system.
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2 Specifications

SEM observation unit
Resolution 1.5 nm (30 kV), 5 nm (1 kV)
Magnification ×20 to ×600,000
Electron gun ZrO/W thermal field emission

Acceleration voltage

0.3-30 kV
0.3-3.0 kV: 10-V steps
3.0-10.0 kV: 100-V steps
10-30 kV: 1-kV steps

Astigmatism correction 8-polar electromagnetism
Blanking Electrostatic blanking
Secondary electron detector 4

Specimen size
φ152 × H15 mm (maximum diameter)
φ50 × H30 mm (maximum thickness)
φ10 × H15 mm (small)

Specimen driving range

X: 0-40 mm
Y: 0-80 mm
Z: 4-36 mm
Tilt: ±7 degrees
−7-45 degrees (φ10 specimen)
Rotation: 360 degrees (continuous)

Specimen driving
5-axis motor drive
X, Y, Z, and T: Stepping motor
R: DC motor

Position memory Position memory and recall functions

Position display

X and Y: 5 digits (three decimal places), in units of mm
Z: 2 digits, in units of mm
R: 4 digits (one decimal place), in units of degrees
T: 2 digits in units of degrees

Image observation
Differential signal: Secondary electron image of roughness (A - B)
Sum signal: Secondary electron image (A + B)
Normal secondary electron image

Screen separation 4-screen tile and stack display

Image display

Still image (video graphic still image)
High-resolution frame memory
Display: 1200 × 900 (slow scan)
600 × 450 (others)
High-speed display (supporting TV scanning)
Printer output: 1200 × 900

Monitor CRT
19-inch high-resolution CRT
SEM image display: Approx.  260 × 195 mm

Scan mode PICTURE, SPOT, LINE X, WAVE FORM, and PHOTO
Scan speed TV, Rapid, Medium, Slow 1-4, and Photo 1-4/Frame
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Auto functions Focus, stigma, contrast and brightness

Data display
µ marker, film number
Acceleration voltage, date, magnification
Keyboard input superimpose

Electrical shift of field of view
X-Y: ±30 µm shift
Rotation: 360 degrees

Storage media for image and
observation conditions

HD
MO (optional)
Ultra high-resolution camera unit (optional)

Output of image and
observation conditions

Digital printer (optional)
Instant photography (optional)
Roll film (optional)

Control PC
PC-AT compatible
OS: Windows NT

Evacuation
Continuous operation (lens evacuation)
Full automatic (specimen chamber evacuation)

Specimen exchange time 10 minutes max.  (when the chamber is vented), 5 minutes max.
(when the pre-evacuation chamber is used)

Ultimate pressure 2.6 × 10−4 Pa (2 × 10−6 Torr)

Vacuum pump

4-inch oil diffusion pump: Pumping speed 280 l/sec
Turbo molecular pump (optional)
Direct coupling oil-sealed rotary vacuum pumps:

Pumping speed 160 l/min
Ion pump: Pumping speed 20 l/sec, 2 pumps

Anti-vibration device for
system frame

Air servo suspension

Safety device Protection functions against power failure, water failure, pressure or
vacuum deterioration

Diagnostic function System operation status is displayed on the CRT monitor.

3D measurement unit
Z-direction resolution 1 nm
Beam scanning Digital scanning
Measurement direction Switchable between X and Y directions

Number of measurement data
items

4,096 items max./line X
4,096 items max./line Y
Maximum number of data items: 250,000

Data display 19-inch CRT (shared with the control unit)
Tilt correction Auto and manual
Zoom function Enlargement of part of data

DISTANCE function
Distance in X and Y directions
Distance in Z direction
Tilt angle

Data storage
HD
FD

Memory 256 MB or more
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Record of display
Digital color printer (optional)
Color hardcopy (optional)

Analysis functions
Contour line, area ratio, peak count, granularity, surface area, bird’s-eye
view, and new JIS standard roughness parameters including Ra, Rx, and
Rmax

Configuration

Standard configuration

System frame 1
Main power supply unit 1
CRT monitor 1
Power box 1
Personal computer 1
Rotary pumps 2
Specimen holders 3 types
Standard supplies 1
Instruction manual (Plain paper) 1
Inspection record (Plain paper) 1

Options

Energy dispersion X-ray analyzer
Color hardcopy
X-Y plotter
Specimen coating unit
Photography units
Specimen holders
Cooling water circulator
Air compressor
Etching unit for SEM specimens
Image filing system
Image processor
Backup power supply for ion pumps
Carbon coater
Backscattered electron detector
N2 leak valve for specimen chamber

Outline view
The system described in the figure has some options.
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2200 min.

2000 min.

Installation conditions

Power supply
Single phase 100 VAC ± 10%, 3 kVA, 50/60 Hz; 1 line
Single phase 100 VAC ± 10%, 2 kVA, 50/60 Hz; 1 line

Installation terminal
100 ohms max.
Two wires of the 3-core cable are for power supply, the remaining one is
for grounding.  Power supply terminals are preferably installed within 30
cm from the grounding terminal.

Room temperature 20°C ± 5°C
Humidity 60% max.
Floor vibration 0.3 gal displacement 2 µmP/P max.
Floating magnetic field 0.2 µT max. (2 mG max.)

Cooling water
Pressure:  1 kg/cm2 min.  Flow rate: 2-4 l/min
PT  1/4 (female screw)
Drain port:  1

Leaking N2 gas
4-6 kg/cm2

PT  1/4 (female screw)

Compressed air
5-10 kg/cm2

PT  1/4 (female screw)
Rotary pump exhaust duct NW25

Utility The electric, piping, and other connection work for this system should be
performed by the customer.

Dimensions and weight
Width × Depth × Height Weight

Main unit 750 × 925 × 1,650 mm 350 kg
Operation unit 1,200 × 800 × 750 mm 100 kg
Oil-sealed rotary vacuum
pump 260 × 570 × 410 mm 30 kg

Power box 360 × 700 × 460 mm 40 kg (with a UPS option)

Installation example
System without options
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3 Service

(1) The warranty period is one year after acceptance of the system.
If a failure for which Elionix is responsible occurs within this period, Elionix will replace or repair the
failed parts without charge.

(2) After expiry of the warranty period, we will provide bona fide and reliable service.
Note that the customer will be charged.
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INSTALLATION
1 Cautions for Installation

(1) Poor power supply
•  If the power supply voltage waveform is not a sine wave, or contains spike noise, use an iron

resonance AC regulator rated at 3.0 kVA or higher.
If a thyristor control regulator or other filter regulator is used, the system performance may not
be guaranteed.

•  If the power supply voltage drifts over the rating, use an AC regulator.
•  Sharing the power line with a device using thyristor control or a large device with a capacitor

input power supply may deteriorate the power supply performance.

(2) Significant disturbance magnetic field
The source of the magnetic field must be removed from the installation site or shielded
magnetically.
Preferably, the following devices should not be installed within 20 meters from the system.
•  Magnetic stirrer • Welding machine*
•  Magnetizer* • Electric discharge machine*
•  Demagnetizer* • Elevator
•  External air-conditioner unit • Device using a leakage transformer
•  Large radio frequency oscillating furnace (Ion pump power supply, etc.)
•  Transformation equipment • Motor generator

You may need to counter a magnetic field if the power line for a device with an asterisk runs near
the system.
Also, you should pay attention to disturbance magnetic fields when your site is within 100 meters
from railroad wire or within 50 meters from a road with a heavy traffic of trucks.
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2 Connection of Cooling Water and Oil-sealed Rotary Vacuum Pumps

(1) Connection of cooling water (not necessary for systems with a turbo molecular pump)
Connect both IN and OUT lines of cooling water.

Figure 2-2  Cooling water connection diagram

(2) Joint pipe for rubber vacuum hoses for rotary pump
When installing the rotary pump out of the clean room, provide a joint pipe for rubber vacuum
hoses of the dimension shown below.

Figure 2-3  Rubber vacuum hose connection and joint pipe dimensions

Main unit Elionix-supplied NC blade hose
Inner diameter: 9 mm
Outer diameter: 15 mm

PT 1/4

AMC-04
or

The customer should
provide either of the
following parts.

a)

AMC-04 Amac joint from
Abe Machinery Co., Ltd. Hose band

Volute nozzle, O.D. 9 mm

PT 1/4 (female screw)

b)

Chamfer (Approx. 15”)

Joint pipe

50 min.

O
.D

. φ
24

The customer should
provide the part below.

Rubber vacuum hose

I.D
. φ

18
 m

in
.

Joint pipe

Rubber vacuum hose

Main unit
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OUTLINE OF THE SYSTEM
1 Principle

SEM systems display a magnified view of the specimen surface on a CRT monitor.
The system uses a fine electron beam to scan a specimen surface as an ordinary TV set does.
The intensity of the resultant secondary electrons are displayed on the CRT in synchronous with pixel
brightness.  Then you can see a secondary electron image obtained from the scanning electron
microscope.  The number of vertical scanning lines is about 1,000.  Since the response time of the
display of secondary electron intensity is about 1/1000 of the time required for scanning one line, the
screen is divided into 1,000 × 1,000 = 1,000,000 pixels.  Through digitization of the brightness of each
pixel, a digital image is displayed, processed, and stored.

Figure 3-1  Principle of scanning electron microscope

Specimen

Vacuum pump system

Detector

CRT

High voltage
generation circuit

Lens excitation
power supply

circuit

Electron beam
scanning circuit

Specimen
chamber

Electron optical
column
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2 Resolution

The resolution of the SEM depends on the size of the scanning electron beam.  When an image at a
magnification of 5,000 occupies a 100-mm square on the CRT monitor, the size of the observation area
is 100 × 1/5,000 = 20 µm.
Assume this area is divided into 1,000 in both vertical and horizontal directions, then each pixel will be a
20-nm square (20 µm × 1/1,000).  This means that, to obtain a clear image at a magnification of ×5000,
the secondary electron generating area for each pixel must be a 20-nm square.  This can be achieved
by limiting the size of the electron beam to about 20 nm.
To obtain a high-resolution image at a high magnification, the size of the electron beam must be small
enough.
When a 100-mm square on the CRT monitor is divided into 1,000 in both vertical and horizontal
directions, each pixel will be a 0.1-mm square (100 × 1/1,000).
The resolution of the human eye is 0.1-0.2 mm.  Therefore you will see the pixels as a seamless image,
not as a mosaic.

3 Secondary Electron Image

Secondary electrons are low-energy electrons generated from the specimen surface due to electron
bombardment.  They are collected with a detector having a high positive voltage (approximately 10 kV)
to let a scintillator (an element that converts electron beam energy into light) to emit light.  The light is
then processed with a photoelectron multiplier to generate an electric signal.  The secondary electron
image of specimen surface is obtained through application of this signal to the control electrode of the
CRT monitor to cause changes in brightness of the CRT.
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Because backscattered electrons emitted from the specimen have a high energy as the incident
electrons do, they travel straight in all directions from the irradiation point.  For this reason, electrons
emitted from specimen areas obscured from the detector are not detected.  The resultant image will
have a contrast as if you see the specimen illuminated by the detector from the electron probe.
(Figure 3-2)

Figure 3-2

On the other hand, in secondary electron images, the specimen is observed from the same direction as
in reflective electron images, but with different contrast.  Due to their low energy level, secondary
electrons cannot be detected as they are, an electric potential is applied to accelerate them for easier
collection.  Secondary electrons emitted in all directions from the irradiation point on the probe are
collected by the detector.  They produce a contrast based simply on radiant exposure, rather than the
contrast observed in reflected electron images.  (Figure 3-3)

Figure 3-3  Detection of secondary electron image

 Detector

Specimen Specimen

Reflected electrons

Secondary electrons

Reflected electron image

Point light source

Secondary electron image

 Detector

Specimen Specimen

10 kV

Shadowless light source
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4 Scanning and Magnification

The electron beam irradiated to the specimen and that irradiated to the CRT screen must always be at
corresponding positions.  This ensures the synchronization between both electron beams during
scanning.  The ratio of the scanning width of one beam to the other is the magnification of the image.

5 Electron Optical Column

The electron optical column generates and emits a fine electron beam for scanning specimens.
Electrons are emitted from the tungsten filament (LaB6 filament on LaB6 guns and ZrO/W emitter on
TFE guns), and condensed into a beam of about 2 nm in diameter by three-stage electromagnetic
lenses.  This process of condensing an electron beam is referred to as focusing.
Electron beams with an elliptic cross-section will cause a “drifted image,” however, this can be corrected
using a stigmeter.

6 Specimen Chamber

The specimen chamber has a stage for specimen transfer and a secondary electron detector.
A fine electron beam emitted from the electron optical column scans the specimen surface, generating
secondary electrons.  These electrons are collected by the secondary electron collector, converted into
electric signals, amplified and sent to the display device.
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Incident angle calculated
from measured values

(degrees)

Incident angle (degrees)

7 Principle of Roughness Analyzer

The emission intensity of secondary electrons generated by electron beam irradiation increases in
proportion to the increase in the incident angle.  Also, the angular distribution of the emission intensity
varies with the incident angle.  Since the measurement of surface contour requires a differential signal,
the system uses a pair of secondary electron detectors A and B.
Assume that the intensities of output signals from detectors A and B at an incident angle of θ are a and
b, the intensities of output signals at perpendicular incident are an and bn, respectively, and K is a
constant, equation (1) gives a good approximation when θ is 75 degrees or smaller.

Tanθ=K × (a2−b2) / (an+bn)2 ......................... (1)

Figure 7-1 shows the relationship between incident angles determined from the equation and the actual
incident angles.  Equation (1) is generally true under normal SEM operating conditions (at an
accelerating voltage of 1-25 kV).

Figure 7-1
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If an and bn set to an equal value through deliberate initial condition setting are entered into a computer,
calculation of output signals a and b from both detectors at the measurement point will deliver incident
angle θ in the X-Z plane.
The contour in the X-axis direction is measured through the integration of the angle of the specimen
surface determined in this way.  The figure below outlines the measurement principle of the system.

Signal a

Signal b

a − b

Incident electrons

ＡＡＡＡ
Secondary electron detector Secondary electron detector

∫ − dxba )(

B
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OPERATION
1 Observation Flow

The flowchart below outlines observation operation.

Press the power buttons on the main PC and
3D analyzer PC and log in to them.
The ERA-8800 software starts up and turns on the control
power.

Power ON

Click the Beam button and select a scan speed.
(A beam is emitted with the previous settings.)

Use the Auto button and corresponding buttons for setting.

(When axis alignment is necessary.)

Use the mouse for setting.

Use the mouse for setting.

Click the Magnification
+/− icon.

(for 3D analysis)

Use the slider button for setting
(not necessary with 8800FE).

HV ON

Filament saturation

Brightness and
contrast adjustment

Field of view shift

Focus and stigma

Changing the
magnification

Saving
the image

Printing
the image

Photograph

Determination of
the field of view

Save buttonPrint buttonPhoto button

The ERA-8800 software terminates and turns off the control
power.  Log off from the 3D analyzer PC and turn it off.

Power OFF

End of observation

Log off from Windows and select Shutdown.
Press the Power button to turn off the PC.

Click the 3D
icon.
Check the level
and start
measurement.

Press the F12
key to switch to
the 3D analyzer
PC.

Meas-
urement

Saving
the data

Output

Analyzing
the data

Axis
alignment

Changing
the spot size

Trans and tilt
adjustment

Setting the
original spot

size

Use buttons.

Use the mouse
for setting.

Select from
the menu.
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This chapter is designed for users who operate the system for the first time.
For high-resolution, low-damage, and low-signal level observation, you must take advantage of the
SEM performance.  You may have to read other chapters and references to understand the
characteristics of SEM.

2 Background Knowledge

1) Mouse operation on the observation screen (focus, stigma, and stage)
With the mouse pointer placed on the observation screen, pressing the right mouse button causes
a menu to appear.  When you select a mouse operation item on the observation screen, the
shape of the mouse icon on the screen changes, allowing the following operations.

① Focal adjustment
You can adjust the focus by moving the mouse to the right or left on the observation screen
while holding down the left button.

② Stigma adjustment
You can adjust the stigma by moving the mouse to the right or left, upward or downward on the
observation screen while holding down the left button.

③ Stage shift (to the center)
You can move the specimen to the center by clicking with the left button the area of the
specimen you want to move to the center of the observation screen.

④ Stage shift (grab and move)
You can move the specimen to a desired position by dragging and dropping it on the
observation screen.

* When one-stage deflection for axis alignment is selected, the following menus are added.

⑤ Trans adjustment (making the center of the image brighter)
You can make a trans axis adjustment, where the beam center is aligned with the axis center,
by moving the mouse to the right or left, upward or downward on the screen while holding
down the left button.

⑥ Tilt adjustment (aligning a round image with the center)
You can make a tilt axis adjustment, where the beam axis tilt is aligned with the optical axis, by
moving the mouse to the right or left, upward or downward on the screen while holding down
the left button.  

In addition, the Distance calculation, Remark input, and Remark delete icons are displayed only
when the button at the upper-left corner of the screen is pressed.
Even when these icons are displayed, you can select a different operation item from a menu that
appears when you press the right mouse button with the pointer placed on the screen.
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3 Turning on the Power

1) You will see a breaker through the window under the control console.
Check that the breaker is turned on.

2) Press the power button to turn on the main control computer (Windows NT).

3) Step 2) above starts the specimen chamber evacuation system.

4) Log in to the PC.

5) Open the door on the right of the main control computer.
Press the power button of the 3D analyzer computer (Windows 98) to turn it on.

6) Press the F12 key on the keyboard to switch the monitor to the 3D analyzer computer, and log in to
it.

4 Starting up the Software

1) Press the F12 key to switch to the main control computer.

2) Double click the ERA-8800 icon on the desktop.

3) Wait until the vacuum indicator in the Beam dialog box goes down to one blue segment.

5 Exchanging the Specimen

1) Check that no beam is emitted.  (When the Beam button is displayed in orange, a beam is
emitted.  Clicking the button turns off the beam.  The button will be displayed in gray.)

2) Click the Evacuation system icon (an icon of a rotary pump) on the toolbar.

3) Click the Vent button in the Evacuation system dialog box.
You can open the door when the hissing sound (meaning that the vacuum is being broken) is no
longer produced.

4) Using screws, fix a specimen table with a specimen to the specimen holder.

5) According to the mark on the specimen holder (a letter M or L, for example, is engraved on the top
of the holder), set the specimen holder contents at the upper-left corner of the GUI screen.

Caution:  Be sure to set the specimen holder correctly.
Improper setting can damage the system.

6) Close the door of the specimen chamber and click the Evacuate button.
The evacuation sequence starts.

7) Wait until the vacuum indicator in the Beam control dialog box goes down to one blue segment.

8) When the vacuum indicator shows only a single blue segment, the vacuum is ready.
Close the Evacuation system dialog box by pressing the × button at the upper-right corner.
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6 Observation Procedure

1) Check that the vacuum indicator in the Beam control dialog box shows a single blue segment only.
Click the Beam button in the dialog box.

2) In the Scan dialog box, select the scan count and total count as desired.
(Initialization of the screen takes several minutes.  You cannot press any button on the screen
while this icon is displayed.)

3) In the Alignment dialog box, set the spot size code value to about 2200.

4) Use the Magnification button to set the magnification to about 100 or less.

5) Press the Auto Contrast Brightness (ACB) button to adjust the brightness.
Or, set the brightness to about 200 and adjust the contrast as desired.

6) Align the axes.  (See 7  Axis Alignment.)

7) Adjust the focus at a low magnification.  To adjust the focus, keep pressing the left mouse button
and move the mouse right and left while the Focus icon is displayed.

8) Adjust the focus as you increase the magnification step by step.  At the final step, increase the
magnification to ×20,000.  Move the stage so that an object comes to the center of the field of
view.  (Avoid choosing a fine and long object, a round object makes the subsequent work easier.
In moving the stage, select Stage shift (to the center) from the menu appearing when you right-
click the observation screen.

9) Press the Hysteresis clear button on the toolbar to clear the hysteresis.

10) Select Stigma adjustment from the menu appearing when you right-click the observation screen.

11) While pressing the left mouse button, slowly move the mouse to the right and left to find the
position at which the best focused view is obtained.  As you decide on the position, release the
left mouse button.  Press the left mouse button again, and move the mouse upward and
downward to find the best focus position.

12) Adjust the focus.
Stigma is properly adjusted if the image goes out of focus equally in all directions when you
intentionally defocus a little.  Set the focus to the best position.
If you see lines extending in any direction when you defocus, further adjustment is necessary.

13) Repeat steps 11) and 12) a couple of times.

14) As you finish the stigma adjustment, observe a specimen while changing the position,
magnification, and focus as desired.  (Once the stigma is adjusted, the object will not go out of
focus so much as you saw during the focal adjustment.  If the object goes out of focus, adjust the
focus.)



21

7 Axis Alignment

When you change the acceleration voltage or spot size, align the axes as necessary.
Always set trans to 0.  In the first stage of axis alignment, set the image shift to 0.

(1) Adjustment of movable aperture only
Set the spot size to an appropriate value.  Press Wobbler-OL and adjust the movable aperture so
that the image does not move.

Beam is not emitted if significant aperture displacement occurs during replacement
of the movable aperture.  In this case, roughly determine a position at a low
magnification with one-stage deflection for axis alignment.
When replacing the hole, pull the knob and turn it.

As you finish this work, press Wobbler-OL again.
Usually, a relatively high resolution will be obtained with this setting.

(2) Adjustment using tilt
If you want to use more beam current or to prevent the image from moving even if the spot size is
changed, take the following steps.
Note that the steps differ depending on the acceleration voltage.

① Set the spot size to 2300 or larger.  Press Wobbler-OL and adjust the movable aperture so
that the image does not move.

② Set the spot size to about 1800.  Using tilt, correct the image movement as compared with the
position at a spot size of about 2300.

The image may disappear at a spot size of 1800 or smaller.  This is not abnormal.
Usually, set the spot size to 1800 or larger.

③ Repeat steps ① and ② until the result converges.
Once a proper adjustment is made, beam memory allows you to use the system with nearly the
same conditions at the next time.

(3) Fine adjustment of movable aperture
For observation at the highest resolution, take the following steps.
Move the focus to the right to defocus the SEM image a little.
Move the movable aperture until you get the clearest view.  A better resolution is obtained by
adjusting the focus again.

Miscellaneous
(1) Observation in the ERA mode at an acceleration voltage of lower than 1 kV causes a slight

difference in magnification.  If this matters, use the SEM mode.

(2) Observation in the ERA mode with a short WD will darken the screen.
If this matters, use the SEM mode.

(3) The 1ch mode provides relatively good secondary electron detection efficiency.  On the other
hand, however, it causes relatively large axial displacement in observation at a low acceleration
voltage.  If this matters, use A+B, A, B, A−B.
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8 3D Measurement

1) This section explains basic observation with a magnification ranging from 1000 to 10000.
For measurement at a magnification out of this range, see Chapter 2 3D Analysis in the Instruction
Manual.

2) Locate a part of the specimen you want to measure and determine a field of view.
The field of view you see on the SEM is the field of view for the measurement.

3) Press the 3D analysis button (an icon of a truncated cone) on the toolbar to display the 3d analysis
dialog box.

4) Press the Stop button in the Scan dialog box to stop the SEM scanning.

5) Press the Start button for the level check in the 3D analysis dialog box you have opened.

6) The level indicator of the level check function starts working slowly.

7) Using the adjustment knob on the balance adjustment box under the monitor, adjust the balance
until the triangle mark of Bal in the level indicator comes near to the center.  The triangle mark will
shake a little, but you do not have to care.  If you do not adjust the balance well, refer to the
Detailed Manual.

8) Then, adjust the contrast and brightness until the blue bar for Ach (channel A) extends over the
whole green area.

9) When you finish the balance adjustment, press the Stop button.

10) Select a measurement point setting (the default setting of 240 × 180 is recommended) and press
the 3D measurement button.

11) The mouse icon changes to a 3D-eyeglass icon, and measurement starts.

12) No button operation is accepted while the icon is changing.

13) After a while, the “A 3D file was successfully created.” message appears.  Press the OK button.
The observation screen reappears.

14) For information on analysis, refer to the manual for the 3D analysis program.

15) Press the F12 function key on the keyboard to display the 3D analyzer PC screen.

16) From the File menu, open the .dat file for the measurement data storage location.

17) Check the roughness.  To move the 3D image to the right, left, upward or downward, use the
arrow keys.  To rotate the 3D image to the right, left, upward or downward, use the arrow keys
while pressing the Shift key,

18) If necessary, save the measurement data as any filename from the File menu.

19) Press the F12 function key on the keyboard to display the Control PC screen.
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9 Observation

1) Press the Beam button in the Beam control dialog box.  The button will turn gray.
Caution:  Be sure to turn off the beam before leaving the system.

The system will need cleaning more frequently.

2) Click the Evacuation system icon (an icon of a rotary pump) on the toolbar.

3) Click the Vent button in the Evacuation system dialog box.
You can open the door when the hissing sound (meaning that the vacuum is being broken) is no
longer produced.

4) Remove the specimen table from the stage.

5) Close the door of the specimen chamber and click the Evacuate button.
The evacuation sequence starts.

6) Wait until the vacuum indicator in the Beam control dialog box goes down to one blue segment.
When the vacuum indicator shows only a single blue segment, the vacuum is ready.

7) Close the Evacuation system dialog box by pressing the × button at the upper-right corner.

8) Exit the ERA-8800 operation program by pressing the × button at the upper-right corner of the
window.  The control system is turned off.

9) Press the F12 key on the keyboard to switch to the 3D analyzer computer, and log off from
Windows 98 and shut down the PC.

10) Log off from the Main Control computer and shut down Windows NT.
Press the power button to turn off the power.

11) You will see the REMOTE/LOCAL switch for the evacuation system through the window under the
control console.  When this switch is at the REMOTE position, the power for the evacuation
system will be turned off after 10 minutes.

10 Other Operation

1) Click the title bar (an area with observation screen display) of the observation screen.  When this
area is shown in blue, you can control the magnification and stage XY positions from the keyboard.

2) Under the condition described in 1), you can change the magnification using the PageUp and
PageDown keys on the keyboard.

3) Use the arrow keys on the keyboard to move the stage.  The field of view moves in the direction of
the arrow key you press.  (This function may not work properly at a high magnification.)
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OPERATION ON EVACUATION SYSTEM AND
ELECTRON GUN
1 Schematic Diagram

1-1 Electrical system

1-2 Evacuation system

Power
distribution panel

OptionEmergency stop

Backup power
supply

Specimen chamber
evacuation system

Main power
supply

Electron gun
power supply

Baking
controller

Lens evacuation
system

: Optional

Turned on for SEM observation.
Usually controlled via the GUI.

Normally turned on.
This will be turned off
before a long vacation.
This should not be turned
on/off frequently.

The chamber is
baked after
electron gun
replacement.

Always turned on.

V4

Electron gun
chamber

SIP1 Lens
evacuation
system

Pirani gauge

Specimen
chamber
evacuation
system

Pirani
gaugePenning gauge

Intermediate
chamber

Exchange
chamber

V5

Specimen
chamber

SIP2

V7

V3

V2

LV2

LV1

LV4DP
(TMP) RP2

RP1

V1
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2 Operation Flow

2-1 Daily operation

Daily startup/shutdown
(including specimen exchange)

↓

* Water valve: Open (Unnecessary for systems with a TMP)
↓

* Air: Always open  N2: Open
↓

* POWER: ON
GUI startup and login: ON

↓

Vacuum OK LED comes on.
↓

* Vent
↓

V1 and V3: CLOSE  V2: OPEN
↓

* Specimen exchange
↓

* Evacuation, EVAC LED (green)
comes on.
↓

Specimen
exchange
process

V1 and V2: CLOSE  V3: OPEN
↓

V3: CLOSE  V2 and V1: OPEN
↓

Vacuum OK
↓

* Beam
↓

* Observation
↓

* Beam: OFF
Exit GUI, log off, and shut down

When the switch in the small window front
of the operation unit is REMOTE , DP will
cool down and all system power will stop
automatically.

↓

* Close the water valve 15 minutes later.
(Steps indicated by an asterisk are taken by the operator.)
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2-2 Shutdown

Shutdown before electric power stoppage, compressed air stoppage and a long vacation.
↓

(*1)
Electron gun: OFF

(See 3-3.)
Confirm EVAC LED (green) comes on, BEAM off .

↓

Exit the GUI and
shut down the system.

When the switch in the small window front of the
operation unit is REMOTE , DP will cool down and
all system power will stop automatically.

↓

(*2)

SIP is kept ON LOCK .
Backup power supply POWER and
BACK UP switches are kept ON .

(See 3-4.)
↓

POWER BOX : STOP
↓

(*3) Fix V7 (gate valve) at the
“Closed” position.

Caution: Insert a screw (M4 × 25) on the side of
V7 and tighten it gently by hand.
Do not use a wrench.

Startup
↓

(*3) Unfix V7.
↓

Confirm START lamp in POWER
BOX is ON

or
Push STOP switch .

↓

(*2)
SIP ON

(See 3-4.)
↓

Log in and start up the GUI.
↓

(*1)
Electron gun: ON

(See 3-3.)

(*1)Steps taken when the SEM is not used for several weeks.
Caution: Turning on/off the electron gun can shorten the device life.

(*2)Steps taken when all power supply must be turned off.
(*3)Steps taken when the compressed air is turned off.
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3 Operation

3-1 Ventilation of chamber See OPERATION ON EVACUATION SYSTEM
AND ELECTRON GUN.

3-2 Pre-evacuation chamber See OPERATION ON EVACUATION SYSTEM
AND ELECTRON GUN.

3-3 Electron gun
CAUTION:   ①   Do not turn on and off the electron gun frequently.  Turn on or off the electron gun

only before or after a long vacation.  Do not change any parameter.
Otherwise, the life of the electron gun may be shortened significantly.

②   Do not change the set values in this dialog box.  Otherwise, the system does not
work properly.

Electron gun: OFF
1) Write the description of the electron gun in TFE emitter

history at the end of this chapter.
2) Turn off the electron gun and wait until the voltages and

currents go down to 0.

Caution:    If you are instructed to stop the ion pump or
disconnect the HV plug, turn off HV POWER
on the POWER BOX.

Electron gun: ON
Caution:    Follow the instruction for initial startup of

electron gun if you have stopped the ion
pump, baked the chamber, or experienced a
worse condition than the set point.  In this
case, startup through the following
procedure can damage the electron gun.

1) Turn  on  HV POWER on the POWER BOX and start
up the GUI.

2) Check that the ion pump current value is smaller than
SP1.

3) Check that the electron gun set values are the same as
the TFE emitter history.

4) Turn  ON  the electron gun.
5) After three hours, check that the vacuum level, electron

gun set and operation values are appropriate and write
them in the TFE emitter history.

Caution: In step 4), if the vacuum level of SIP1 deteriorates
to cause a vacuum error, wait for the vacuum to restore
to the appropriate level, turn  off  the electron gun
and turn it  on  again.
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Initial startup of electron gun

1) Turn on HV POWER on the POWER BOX and start up the GUI.
2) Check the current of the ion pump power supply.

SIP up SIP down
Current µ µ

3) Press the SP1 button on the on-pump power supply (IP up) and check the current of the set point.
When the value differs, set it to the specified value (4 µA) using a slotted screwdriver.

4) Check that the set and operation values are written in the TFE emitter history.
If not, take a note of the set values here.

Set value
Filament current

Suppressor voltage
External voltage

5) Using the Filament current, Suppressor voltage, and External voltage buttons, set the values to 0.
6) Turn [ON] the electron gun.

While watching the vacuum level, raise the filament current to the set value in the following
manner.
Then, proceed to step 7) immediately.
① Set Ich to 1.5 A.
② Raise the current to the specified value at a rate of 0.1 A/min.
Caution: An external voltage below 1 kV continuing for 10 minutes triggers the LOW Vex

interlock, shutting down the power.  This is not a failure.  Turn  off  the electron gun
and turn it  on  again.  The voltage will rise to the current setting.

7) Set the suppressor voltage to the previous value.
8) While watching the ion pump ammeter, raise the external voltage to the previous set value in the

following manner.
① When Iem is below 10 µA, allow 5 minutes for a 5 µA step.
② When Iem is above 10 µA, allow 5 minutes for a 10 µA step.

9) Wait at least one hour after turning on the filament, then apply an acceleration voltage.
When applying a voltage for the first time, take the following steps.
① Apply 10 kV to display a SEM image.
② While checking that no ripple occurs on the SEM image or the vacuum in the electron gun

chamber is maintained, raise the voltage in a 1-kV step to the desired value.
③ Observe the SEM image to make sure that the operation is normal.

10) After three hours, check that the vacuum level, gun controller set and operation values are
appropriate and write them in the TFE emitter history.
Caution: ① If the vacuum level of SIP1 deteriorates to cause a vacuum error, wait for the

vacuum to restore to the appropriate level, turn  off  the electron gun and turn
it  on  again.

② Whenever you bake the electron chamber, you have to readjust the gun alignment.
Contact Elionix service representative for this work.

③ If Iem is lower than the previous value, it often recovers with time.
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3-4 Ion pump

Caution: ① When all the power supplies have been turned off for a prolonged period (more than 3
hours), 3-day baking work is required.  We recommend you to connect the ion pump
power supplies to an uninterruptible power supply.
(In connecting the ion pump power supplies to an uninterruptible power supply, take the
connection steps and connect the AC plug of the two ion pumps to the uninterruptible
power supply.  Check that the readings on the ammeters on the two ion pump power
supplies return to the normal level.  Now you are prepared for a prolonged power
failure.)

② When you turn off all power supplies due to a power failure lasting for a short time (more
than 15 minutes), you have to turn off the ion pump power supplies.

Ion pump OFF

1) Stop the electron gun operation following the instructions in Operation on the electron gun.
2) Wait for 30 minutes to let the electron gun cool down.

Caution:  When you vent the chamber, wait for one hour.
3) Record the readings on the ammeters on the two ion pumps in TFE emitter history.
4) Turn the  HV  switches on the two ion pumps to the  OFF  position.
5) Turn OFF the  POWER  switches on the two ion pumps.

Ion pump ON

1) Turn ON the  POWER  switches on the two ion pumps.
2) Turn the  HV  switches on the two ion pumps to the  ON LOCK  position.

If the Overload lamp does not go off or the Set point SP1 lamp does not come on, contact us.
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4 Interlock

1)  Interlock

Condition Result

Specimen chamber vacuum < 1 × 10−3 Pa
V7 OPEN
Vacc READY

OK
OK

Specimen chamber vacuum < 5 × 10−3 Pa BAKING OK
V7 CLOSE VENT OK
Two conditions above Exchange chamber operation OK
Two conditions above and exchange chamber
evacuation completed V5 OPEN OK

V5 CLOSE Exchange chamber VENT OK
Electron gun chamber vacuum < 2.6 × 10−6 Pa
and Vacc READY

HV CONTROLLER ON
Vacc ON

OK
OK

2) Safety/Warning  If an anomaly occurs, the system enters a status as shown in the table below.

Anomaly System safety/warning status Remarks

Power failure
All valves: CLOSE
Total system shutdown

At power recovery, only SIP 1 and
2 resumes.

Water failure
All valves except V2: CLOSE
DP: OFF
GUN HV: OFF

At water recovery, the system turns
off and restarts.

Specimen
chamber
vacuum
deterioration

When the specimen chamber vacuum
reaches VACUUM (HV) READY and
deteriorates, the buzzer sounds, the
Vacuum lamp comes on, and V7
closes.

The system resumes as the cause
is removed.

Electron gun
chamber
vacuum
deterioration

GUN HV: OFF
V7: CLOSE

The system restarts as the cause is
removed.

Air pressure low

When the air pressure drops below
the set value of the pressure sensor, a
warning is issued and the red AIR
lamp comes on.
All valves: CLOSE

Fix gate valve V7 by lightly
tightening an M12 screw on the
back of the valve.
The system restarts as the cause is
removed.

N2 pressure low

When the N2 pressure drops below
the set value of the pressure sensor, a
warning is issued and the red N2 lamp
comes on.
The buzzer sounds.

The system resumes as the cause
is removed.
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PANELS AND DIALOG BOXES
1 Panels

POWER BOX

 MAIN  A power supply breaker for the whole system.

 SIP Power supply breakers for the following components:
Sputter ion pump
Turbo molecular pump (optional)
Penning gauge
HV tank

 BAKING  A power supply breaker for the baking controller.

 START  A lamp indicating that the system is supplied with power.

 STOP  Stops the entire system operation.
When this button is pressed again, the system restarts.

Power boxMain power supply



32

Main power supply

 MAIN  A power supply breaker for the main power supply.
Under normal conditions, this breaker is kept on.
It is usually controlled by the main control computer.

 LOCAL/REMOTE
A switch of the main power supply.
Under normal conditions, this switch is at the  REMOTE  position.
It is usually controlled by the main control computer.
At the  LOCAL  position, operation of the specimen chamber evacuation system
continues even if the main control computer is shut down.

BAKING CONTROL

Controls baking operation of the electron gun chamber and ion pumps.
Caution:    Baking operation must be done by our service personnel.

Improper operation can damage the system.
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2 Dialog boxes

1) Beam control dialog box
① Beam button

Turns ON/OFF the filament current and
acceleration voltage.

② Vacuum level indicator
When only a single green segment is
displayed, vacuum is ready.
At the atmospheric pressure, green, yellow,
and orange segments are all displayed.
As the vacuum level improves, the number
of segments reduces.

③ Emission current
The value of the current emitted from the
electron gun.

④ Acceleration voltage display and
acceleration voltage setting buttons
A field that shows the electron optical
column acceleration voltage setting and
buttons for setting that voltage.
Pressing the right arrow button increases
the acceleration voltage and the left arrow
button decreases it.

⑤ Dialog box expansion button
A button used to view the full dialog box.
Pressing this button expands the dialog box,
displaying buttons including Filament timer.

2) Expanded Beam control dialog box

Filament timer indicator
Displays accumulated time of filament current
application.
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3) Alignment dialog box

① Spot size selection buttons
Buttons used to select a spot size.
Stores four spot sizes as Small, Medium, Large, and Free in addition to the contrast and
brightness values for respective spot sizes.

② Spot size display and spot size setting buttons
A field that shows the current spot size setting and buttons for setting the spot size.
Pressing the right arrow button increases the spot size set value (CL code) and the left arrow
button decreases it.
Pressing the right arrow button decreases the spot size (beam diameter) and the left arrow
button increases it.

③ Rough adjustment button for spot size setting
Selecting the Rough adjustment button for spot size setting increases the increment of the spot
size.

④ One-stage deflection for axis alignment selection button
Selecting the one-stage deflection for axis alignment selection button changes the electron
optical column from two-stage deflection to one-stage deflection.
Use this button in axis alignment.

⑤ Dialog box expansion button
A button used to view the full dialog box.
Pressing this button expands the dialog box, displaying controls including Stigma, Trans, and
Tilt.
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4) Expanded Alignment dialog box
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The expanded Alignment dialog box provides the following additional controls.

① Stigma setting XY control
A field that shows the stigma setting for beam astigmatic correction and buttons for setting this
value.
Selecting Rough adjustment increases the increment of the set value.

② Gun alignment memory selection buttons
Three sets of stigma, trans, and tilt values are stored with a name of 1, 2, and 3.

③ Wobbler setting control
A control that changes the current flowing through the OL (focus coil) and CL (condenser lens)
with time.
This is not used in normal observation.

④ Trans adjustment XY control
A field that shows the trans setting for beam axis alignment and buttons for setting this value.
This control is used for trans axis adjustment where the beam center is aligned with the axis
center.
Selecting Rough adjustment increases the increment of the set value.

⑤ Tilt adjustment XY control
A field that shows the tilt setting for beam axis alignment and buttons for setting this value.
This control is used for tilt axis adjustment where the beam axis tilt is adjusted to the optical
axis.
Selecting Rough adjustment increases the increment of the set value.

⑥ Dynamic focus setting control
This control is used to change the focus position in accordance with the specimen tilt.

⑦ Dialog box contract button
The [−] button at the upper-right corner of the dialog box contracts the dialog box to the
standard size.
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5) Positioning dialog box(See Restrictions on shift.)

① Stage shift XY control
A control for moving the stage in the X and Y directions and a field showing the X and Y stage
positions.
Pressing the X or Y shift button moves the field of view in the direction of the arrow.
The Fine adjustment, Standard, and Rough adjustment buttons change the amount of shift
caused by the X and Y shift buttons.
The ranges of shift are 0 to 36 mm in the X direction and 0 to 76 mm in the Y direction.

② Stage XY position initialization button
Moves the X and Y stage positions near to the rotation center of the stage.

③ WD setting control
A control for changing the work distance position of the stage.
The stage moves vertically.
The range of shift is 4 to 36 mm.
Typical WD values are preset.  Pressing the down arrow button opens a box.  Select a value
from the list.
To specify a value not appearing on the list, from the keyboard, enter a value within the shift
range above into the field in units of mm.

④ Dialog box expansion button
A button used to view the full dialog box.
Pressing this button expands the dialog box, displaying controls including Image shift, Stage
rotation, and Image rotation.
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6) Expanded Positioning dialog box
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The expanded Alignment dialog box provides the following additional controls.
(See Restrictions on shift.)

① Image shift XY control
A control for electrically shifting the field of view in the X and Y directions and a field for
showing the X and Y amounts of the image shift used to move the field of view at a high
magnification.
Pressing the X or Y shift button moves the field of view in the direction of the arrow.
The Rough adjustment button increases the amount of shift caused by the X and Y shift
buttons.
A great image shift amount may cause stigma deterioration in observation at high resolutions.
In doing such observation, use a small shift amount.

② Image shift XY position initialization button
Sets the electric shift correction to 0 to initialize the X and Y positions of image shift.

③ Stage rotation control
Buttons for stage rotation and a field showing the rotational position of the stage.
The range of shift is 360-degree endless rotations.
When the ±15 degrees button is selected, pressing the button makes a 15-degree turn.
When the ±15 degrees button is not selected, pressing the button makes a 0.5-degree turn.

④ Image rotation control
Buttons for electrically rotating the field of view and a field showing the rotational position.
The range of shift is 360-degree endless rotations.

⑤ Image rotation initialization button
Sets the electric shift correction to 0 to initialize the image rotation position.

⑥ Stage tilt setting control
A control for changing the tilt position of the stage.
This turns the stage around the WD position and tilts the specimen.
The range of shift is −7 to +45 degrees.
Typical tilt values are preset.  Pressing the down arrow button opens a box.  Select a value
from the list.
To specify a tilt not appearing on the list, from the keyboard, enter a value within the shift range
above into the field in units of degrees.

⑦ Dialog box contract button
The [−] button at the upper-right corner of the dialog box contracts the dialog box to the
standard size.
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7) Scan dialog box

① Scan speed selection buttons
Buttons used to select a scan speed.  Choose a scan speed from the four choices, TV, Rapid,
Medium, and Slow and start a scan.
At the beginning of a scan, it may take time for setting the image processor.
Press the Stop button to stop the scan before starting spot, line profile, or 3D measurement.

② Integration setting control
A control for setting the number of integration averaging processes for each pixel of
observation images.
Pressing the down arrow button opens a box.  Select the number of times of processes from
the list.
This control is applied to the TV, Rapid, and Medium scan speeds.

③ Cross mark button
Displays a cross mark.
You can change the cross mark position using the X and Y cursor move buttons at the bottom
of the dialog box.  Pressing the Initialization button moves the cross mark to the center.

④ CB monitor button
Displays the information on observation image brightness in waveforms.
Pressing the CB monitor button, or the X and Y cursor move buttons at the bottom of the dialog
box refreshes the waveform.
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⑤ Spot operation selection button
A button used to select spot operation.
Pressing this button locks the beam on the intersection of the cross mark.
You can change the beam position using the X and Y cursor move buttons at the bottom of the
dialog box.
Press the Stop button to stop the spot operation selection before starting spot, line profile, or
3D measurement.

⑥ Line profile operation selection button
A button used to select line profile operation.
This function scans in the horizontal direction at a speed used for scanning one screen of slow
scanning.  The result is shown in a waveform.  This is typically used to display a waveform of
rate meter output during EDS analysis.  Select the RM mode in the Main dialog box.
When the A, B, A+B, or A−B mode is selected in the Main dialog box, the waveform of the
selected signal is displayed.
The scanning speed for slow scanning can be changed from the pulldown menu in the Scan
menu on the tool bar.  The change becomes valid when you start a new scan.

⑦ Photo button
A button used to start photographing when an optional photography unit is connected.
Remove the light shield panel from the photography unit and press the Photo button.
The photographed image appears on the observation screen.  When the image display
completes, put back the light shielding panel and remove the photographic paper.
To save the image as a file, use the File menu on the menu bar while the image is displayed on
the screen.

⑧ Example of data record display on the photography unit
An example of data record display on the photography unit is shown below.

Example of data record display

Image number → A serial number assigned to a stored file or photograph.
Acceleration voltage → The current acceleration voltage of the gun.
Micron bar → Corresponds to the bar displayed above the number.
Magnification → Magnification of the observation screen (120 × 90 mm).
CH → Observation mode currently used.
Date → Automatically updated by the internal clock.

Manual date setting is also possible.

UH1428 30.0 kV 1 µ 10 kX A 020326

Image number Acceleration
voltage

Micron bar Magnifi-
cation

CH Date
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8) Main dialog box

① Sample holder size field
A field for displaying the size of the sample holder loaded in the specimen chamber.

② Contrast adjustment control
A control for adjusting the contrast of the observation image and a field showing the contrast
value.

③ Brightness control
A control for adjusting the brightness of the observation image and a field showing the
brightness value.

④ Automatic contrast brightness button (ACB button)
A button for starting automatic contrast and brightness adjustment on the observation image.
When you select this button, the shape of the icon changes and automatic adjustment starts.
Wait until the icon takes the original shape.
This will take 5 to 10 seconds.

⑤ Focal adjustment control
A control for adjusting the focus of the observation image and a field showing the focus value.
Focus values are also known as OL codes.  Selecting the Rough adjustment button increases
the increment of the focus value.

⑥ Automatic focal control button (AFC button)
A button for starting automatic focal adjustment on the observation image.
When you select this button, the shape of the icon changes and automatic adjustment starts.
Wait until the icon takes the original shape.
This will take 30 to 45 seconds.

⑦ Automatic stigma control button (ASC button)
A button for starting automatic stigma adjustment on the observation image.
When you select this button, the shape of the icon changes and automatic adjustment starts.
Wait until the icon takes the original shape.
This will take 60 to 90 seconds.
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⑧ Magnification control
A control for setting the magnification of the observation image and a field showing the
magnification.
The [−] button decreases the magnification and the [+] button increases it.

⑨ Mode selection control
Buttons for selecting the display mode of the observation image.
The choices are A, B, 1ch, A+B, A−B, EXT, XR, and RM.
• The A mode shows an observation image as if illuminated by a light source on the left.
• The B mode shows an observation image as if illuminated by a light source on the right.
• The 1ch mode shows an observation image generated by the far-left detector only.
• The A+B mode shows an observation image generated as the output sum of all the four

detectors.
(This image is an observation image reflecting the componential difference of the
specimen.)

• The A−B mode shows an observation image generated as the output difference between
the right and left detectors.
(This image is an observation image reflecting the contour difference of the specimen.)

• The EXT mode is used when an optional detector is added.
• The XR mode is used when an optional EDS analyzer is added.

(With an EDS analyzer, a mapping image is displayed.)
• The RM mode is used when an optional EDS analyzer is added.

(When an EDS analyzer is added, this mode is used to display a waveform of rate meter
output using the line profile function.)

⑩ Image selection control
Buttons for selecting the image mode of the observation image.
The choices are secondary electron image and reflected electron image.
In the secondary electron image mode, a high voltage is applied to the detectors to collect
secondary electrons.
In the reflected electron image mode, the detectors are free from a high voltage for secondary
electron collection.



44

9) Magnification memory dialog box

The Magnification memory dialog box can be opened from the Magnification memory menu on the
menu bar.
Set a value for Magnification 1, Magnification 2 and Magnification 3 in the Magnification memory
menu on the menu bar.

10) Position memory dialog box

The Position memory dialog box can be opened from the Position memory menu on the tool bar.
You can register up to 20 stage positions to which the stage moves.
When the Registration button is selected, pressing a number button stores the current position in
the memory.
When the Move button is selected, pressing a number button moves the stage to the position
stored in the memory.
When the View button is selected, pressing a number button displays the information stored in the
memory.
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11) Properties dialog box

This dialog box is opened from Property configuration in the File menu on the menu bar.
① Image number

You can enter the two initial letters of an image number in upper cases.
The counter value of the image number increments automatically each time you store or
photograph the images.  Using the Reset button, reset the counter value to 0001.
An image number is shown on the lower-left corner of the observation screen.
It is also included in photos taken with the photography unit.

② Date
When the automatic date setting is selected, the clock function of the PC displays the current
date on the lower-left corner of the observation screen.  The date is also included in photos
taken with the photography unit.
When the manual date setting is selected, the date you entered into the Date field in the
character string format for automatic setting is displayed on the lower-left corner of the
observation screen.  The date is also included in photos taken with the photography unit.

③ Specimen name
Enter a specimen name in the upper field.
The character string you have entered is listed in the lower box, and can be called by clicking it
with a mouse.
Pressing the Delete button deletes the selected character string.

④ Operator name
Enter an operator name in the upper field.
The character string you have entered is listed in the lower box, and can be called by clicking it
with a mouse.
Pressing the Delete button deletes the selected character string.

⑤ Label
Enter a label name in the field using upper-case letters and numerals.
This is shown on the lower-left corner of the observation screen.
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12) ERA and SEM mode selection buttons

 ERA  

 SEM  

This section describes the  ERA  and  SEM  buttons at the left of the tool bar.
Use them to switch between ERA and SEM modes.

①  ERA  button
Press this button for cross-section measurement.
In the ERA (3D roughness analysis) mode, a bias voltage is applied to the specimen to
improve detection efficiency.

②  SEM  button
Press this button for advanced SEM observation.
In the SEM mode, unlike the ERA mode, no electrical assistance is used.
You do not have to press this button for normal SEM observation.

13) EDS mode selection button

 EDS  

This section describes the  EDS  button at the left of the tool bar.
Press this button to enter the mode where the ERA-8800 beam is scanned from the EDS unit.
In this mode, the ERA-8800 beam is deflected by scan signals from the EDS.
Note that you cannot display an image on the ERA-8800.
Images can be displayed on the EDS only.
Operation including focal, contrast, brightness, and magnification adjustment can be done on the
ERA-8800 even when an analysis is in progress on the EDS.
To quit the operation on the EDS, press the Mode switch button on the EDS (the EXT-XY button on
the EDAX).  The ERA-8800 returns to the normal operation mode.
Alternatively, on the ERA-8800, select Exit slave mode in the Analyze menu on the menu bar
causes the unit to return to the normal operation mode.



47

14) Image processor menu

The Image processor menu is included in the View menu on the menu bar, allowing real-time
display and photography of the image being processed.
The available processes are as follows:

① Gamma correction
Three levels of image contrast correction can be selected.

② Edge enhancement
The clarity of the image edge is enhanced.  Three levels of clarity can be selected.

③ Image inversion
The tone gradient of the image can be inverted (into negative).

15) View layer menu

The View layer menu is provided in the File menu on the tool bar.  This allows you to overlay a
stored image with another on the screen.
This function is used to view a stored SEM image overlaid with a stored X-ray mapping image
when an EDS unit is connected.
When this menu is selected, a dialog box for opening base and layer images from a file appears.
This dialog box has a palette allowing the user to specify a color of the layer image.
The steps for using layer view are as follows:

① Click the color palette on the layer image.  On the color palette, double-click a color you want
to choose.

② Click the […] button.  A dialog box for opening a file appears.
Select, for example, a SEM image as a base image.

③ Click the […] button.  A dialog box for opening a file appears.
Select, for example, an X-ray mapping image as a layer image.

④ The X-ray mapping image selected as the layer image, in the color you have specified, is laid
over the SEM image selected as the base image.

Note) Since the layer image is generated through the binarization of a stored image, the micron
bar and date at the bottom of the screen will have a color.  This is not a failure.
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16) Multi-image dialog box

This dialog box appears when you click the Multi-image button (an icon of a plus sign enclosed in a
square) on the tool bar.  In the Multi-image window, images in the display mode selected with the
button are displayed as still images.
The procedure is as follows:

Note:  Before using this dialog box, freeze the normal scan images.

① Select the Multi-image button.  Wait until the icon changes to the normal icon.

② Select a display mode for each of images 1 through 4.

③ Press the Scan button for the position you want to capture an image.

④ Wait until the icon changes to the normal icon and the image appears.

⑤ Press the Scan button for the position you want to capture the next image.

⑥ To finish multi-image capturing, press the Stop button.
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17) Power supply voltage monitor

This dialog box appears when you select Power supply voltage monitor from the Options menu on
the menu bar.  Pressing the Read button displays the operating voltage of the power supply.

18) Lens power supply monitor

This dialog box appears when you select Lens power supply monitor from the Options menu on
the menu bar.  Pressing the Read button displays the operating voltage of the lens power supply.
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19) Enter remarks button

You can overlay the observation screen with remarks using the Pencil and Eraser icons in the Main
dialog box.
The procedure is as follows:

Entering a remark character string

① With an observation image on the screen, click the Pencil icon.

② The mouse icon changes to an icon of a pencil.

③ Click the position you want to enter characters.

④ A Character input dialog appears.  Type remarks from the keyboard.

⑤ The remarks are not recorded in the photography unit.

Erasing a remark character string

① Click the Eraser icon.

② The mouse icon changes to an icon of an eraser.

③ Locate the mouse pointer to a remark character you want to erase, while pressing the left
mouse button, move the mouse as you rub over the character.  Characters are deleted as if
you are using an eraser.

④ If you cannot be bothered to take these steps, click the Wiper icon on the tool bar to delete the
entire remarks at a time.
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20) Evacuation system dialog box

This dialog box appears when you select Evacuation system in the Options menu on the menu bar
or press the Rotary pump icon on the tool bar.  This dialog box indicates the operation of the
evacuation system.  Buttons for evacuating and venting the specimen chamber are provided.
When it is expanded, the gate valve open/close buttons and vent buttons for an optional pre-
evacuation chamber become available.

To open the specimen chamber, press the Vent button.  To evacuate the chamber after
exchanging the specimen, press the Evacuate button.

In using an optional pre-evacuation chamber, install a specimen exchange unit equipped with a
specimen exchange rod to the pre-evacuation chamber, and press the Open button for the pre-
evacuation chamber.  After evacuation of the pre-evacuation chamber, the gate valve opens.
Using the exchange rod, take out the specimen to the pre-evacuation chamber.  Press the Close
button to close the gate valve.  On the status display, check that the gate valve is closed.
Then vent the pre-evacuation chamber and take out the specimen.
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21) Beam memory dialog box

The Beam memory dialog box can be opened from the Beam menu on the tool bar.
You can register, view, and configure up to 10 sets of beam conditions.
When the Registration button is selected, pressing a number button stores the current conditions
in the memory.
When the View button is selected, pressing a number button displays the condition set stored in
the memory.
When the Configure button is selected, pressing a number button sets the beam according to the
condition set stored in the memory.
When the configuration completes, the Hysteresis clear and Auto contrast brightness (ACB)
functions start automatically.
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STAGE
1 Overview

The X, Y, WD, R, and T axes are driven by motors.
Several types of specimen holders are provided, allowing you to observe various kinds of specimens
according to your needs.

2 Shift Range

See below.

X-axis (X-axis shift) 0 to 40 mm
Y-axis (Y-axis shift) 0 to 80 mm
WD (work distance) 4 to 36 mm (TFE)
R-axis (specimen rotation) 360-degree endless rotation
T-axis (specimen tilt) −7 to +45 degrees

Note) Specimen shift is restricted depending on specimen holder size, X-axis position, WD, T-
axis position, acceleration voltage, and magnification.
If the stage moves beyond the shift range, the control PC warns with a beep.
Restrictions are placed to control stage shift beyond the range.  However, if the stage
crosses the border, the stage shift may be prohibited and the stage may not move.
In this case, increase the WD and change the conditions you have entered last into the
safety side.

Maximum specimen
dimension
φ152

3D measurement range
φ125Y: 80

X: 40

Rotation axis 2
(Small specimen)

Rotation axis 1
(Large specimen)

XY shift range



54

3 Stage Shift Restrictions

① Specimen holder S (brimless φ10 specimen holder)
When WD < 15.00

00.00 ≦ X ≦ 40.00
00.00 ≦ Y ≦ 80.00
T = 00.00 Note)  Move within WD < 15.00 only when T = 00.00.
R: No restrictions

When WD ≧ 15.00
If 28.50 < X ≦ 40.00
00.00 ≦ Y ≦ 80.00
−7.0 ≦ T ≦ +7.0
R: No restrictions

If 0.00 ≦ X ≦ 28.50
00.00 ≦ Y ≦ 80.00
−7.0 ≦ T ≦ +45.0
R: No restrictions

② Specimen Holder M, L, X
When WD < 15.00

00.00 ≦ X ≦ 40.00
00.00 ≦ Y ≦ 80.00
T = 00.00 Note)  Move within WD < 15.00 only when T = 00.00.
R: No restrictions

When WD ≧ 15.00
00.00 ≦ X ≦ Xmax
00.00 ≦ Y ≦ Ymax
−7.0 ≦ T ≦ +7.0
R: No restrictions

③ When an EDS option is used
0 ≦ T Note) Condition ③ is added to conditions ① and ②.
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4 Specimen Holder

Size：　　　　φ50×H30  (M)

Size：　　　　φ152×H15  (L)

Size：　　　　φ10×H15  (M)
            
Without fringe           (S)
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Size：　　　　Standard sample (M)

Option

Size：　　　　φ1 inch  (M)

Option
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５５５５ How to Change Specimens

1)  If the electron beam is ON, first click the BEAM OFF at the Beam Control Dialog box.
Now close the isolation valve.

2)  Leak the specimen chamber by clicking the VENT button in the Evacuation System Dialog
box.

3)  The leakage takes 1 to 2 minutes. When the leakage is complete, draw out the specimen
stage.

4)  Unload the specimen holder from the stage.
　　Caution：Some types of holders cannot be unloaded unless the specimen is first removed.
Note: The procedures following demonstrate steps for the φ10 specimen holder.
5)  Dismount the specimen by unscrewing the block fixing screw (see the photo shown above).
6)  Mount the next specimen onto the specimen holder.
　　Adjust the specimen height to the top face of the holder by turning the height adjusting
screw.

　　Caution：The connection between the specimen and holder needs to be conductive.
　　　　　Also, when the specimen itself is not conductive, a metal coating is needed. Coat

the specimen using the coating system (the coating system is optional).
7)  Load the specimen holder onto the stage.
8)  Ensure that no dust is on the O-ring, then close the specimen chamber.
9)  Evacuate the specimen chamber by clicking the EVAC button in the Evacuation System Dialog.
This makes the EVAC button turn green.

10) The vacuum-degree indicated by the green digital-bit meter lessens as the vacuum improves.
When all the bit indicators except the very last one have gone out, the Vacuum OK indicator
in the Evacuation System Dialog box turns green. Then the electron beam can be irradiated
onto the specimen.

Block Fixing Screw

Height Adjusting Screw
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Exchanging the specimen from the pre-evacuation chamber

On systems with an optional pre-evacuation chamber, you can exchange specimens without venting the
specimen chamber.  Only φ10 specimen holders can be exchanged.

1) Screw the end of the specimen exchange rod into the specimen holder with a specimen.

2) Pull the exchange rod so that the end is clamped by the exchange rod clamp.

3) Press the lid tightly against the exchange chamber.  Press the  Open  button for the pre-
evacuation chamber in the expanded evacuation system dialog box.

4) The stage moves to the exchange position and the pre-evacuation chamber is evacuated.

5) When the pre-evacuation chamber is evacuated to the predetermined pressure, valve (V5) opens.

6) Insert the exchange rod slowly to put the specimen holder inside the chamber, and place the
specimen holder precisely on the turntable.

Caution:  ①①①①   Look the inside through the window during work.
②②②②   The stage may be moving even if V5 opens.  Put the holder after the stage

stops.  Otherwise, the stage may be damaged.
③③③③   Put the specimen holder precisely on the turntable.  Otherwise, the system

may be damaged.
7) Turn the exchange rod counterclockwise to remove it from the specimen holder.

8) Pull the exchange rod to the original position so that the end is clamped.

9) To vent the pre-evacuation chamber, press the  Close  button for the pre-evacuation chamber in
the expanded evacuation system dialog box.

10) Remove the specimen exchange rod and use the cover.

Specimen holder

Clamp

Airtight installation on the
pre-evacuation chamber

Cover

O ring for specimen
exchange rod
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MAINTENANCE
1 Cleaning Procedure

This chapter describes typical cleaning procedures.

1)      Cleaning 1: Cleaning the aperture (molybdenum)

When replacing the aperture, use a new part.
You may take the following steps, but the performance is not guaranteed.
Install a basket heater or boat made of a high melting point metal to a vacuum deposition
equipment and preheat it in a vacuum.  Heat the heater or boat for about 10 minutes at a
temperature at which it glows white hot (approximately 1500°C).  Upon completion of heating,
leave it in the vacuum for about 20 minutes.  Place the diaphragm on it and heat it in the same
way.  After heating, install it on the holder while taking care that it does not contact anything.
Then evacuate the chamber.

2)      Cleaning 2: Cleaning extremely contaminated areas

This applies to areas contaminated with polymerized hydrocarbons and discharging areas.
Note that CLA and OLA are not included.
① Wrap an end of a bamboo or wooden stick with absorbent cotton.  Put POL*1 polish on the

cotton.  Or, put POL on a lint free cloth.
② Polish the contaminated areas until the glittering base metal appears.
③ Use absorbent cotton or cloth with a solvent*2 to wipe off the remaining POL.

Repeat this step until no stain comes off when you wipe it hard.
④ Perform ultrasonic cleaning for about three minutes.

Note: *1 You may use Pikal also.
*2 Do not use other solvents.

Never use ligroin, benzine, and benzene.

3)      Cleaning 3: Cleaning less contaminated areas

Use gauze, rayon sheet, or absorbent cotton or cloth with an organic solvent to wipe off the stain.
Never use benzine or benzene.
To clean the inside of holes or cylinders, use cotton buds, toothpicks or chopsticks wrapped with
absorbent cotton.
To clean a hard-to-access areas or screws, soak them in a solvent or use a brush.
Do not use a brush to clean the inside of cylinders, aperture, and holes in hole pieces which must
be free from minor scratches.
As soon as you finish cleaning, blow off the remaining cleaning fluid using a hand blower.
An ultrasonic washer is a very effective device.

4)      Cleaning 4: Cleaning the beam emission hole in the wenelt.

Following Cleaning 2, add kerosene to the metal polish and clean the hole in the same way.
Do not polish any other areas than the wenelt using the same wiper.

5)      Cleaning 5: Cleaning of areas with particles

Blow the particles off using a high-pressure N2 gas (~3 kg/cm2) blaster or an N2 aerosol.
Wash O rings with a solvent and take the above steps.

Store cleaned parts or assemblies in a desiccator containing deoxidant or in a solvent.
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Refer to the list below as necessary to prepare for cleaning,

1) Items for cleaning
•  Bamboo (wooden) sticks • Plastic bag
•  Absorbent cotton • Aluminum foil
•  Lint-free cotton • Ultrasonic washer
•  POL polish (metal polish) • Polyethylene or rubber gloves
•  Solvents (ethanol and acetone) • High pressure (about 3 kg/cm2) N2 gas
•  Beaker

2) Jigs and tools
•  Jigs • Loupe
•  Tools • Lighting equipment (with a stand)
•  Tweezers

3) Parts for backup
•  Filament
•  Condenser lens aperture (CLA) and objective lens aperture (OLA)
•  O rings

Overhaul cycle

Part/unit Cycle Method

Movable ribbon aperture (OLA) 1 month
Replacement

or
Cleaning 1

Specimen exchange rod As necessary Grease up

Movable aperture holder

As necessary
or

At the time of
overhaul

Cleaning 2

Note: 1) For overhaul procedure for pump and vacuum equipment, see the corresponding
instruction manual.

2) The customer can perform the above items.
Other parts on thermo field emission electron gun (TFE) models are overhauled when
the emitter is replaced.
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2 Cleaning

2-1 Replacing the movable aperture

Among the parts of EOC (electron optical column) of TFE gun models, the movable aperture is the only
one that requires daily cleaning.
The other parts are cleaned when the TFE emitter is replaced.

1) Close the gate valve and vent the specimen chamber.

2) Remove the movable aperture unit by loosening the two fixing screws.
Hold the unit not to lean it.

3) Using clean tweezers, remove the two fixing leaf springs and remove the ribbon aperture.

4) Set a new aperture, place the holder and fix them with the fixing leaf springs.

5) Install the unit at a horizontal position.

6) Evacuate the chamber again.

2-2 Specimen exchange rod

If you feel increased resistance to the movement of the specimen exchange rod, apply the grease
supplied as a standard accessory.  Apply grease to the specimen exchange rod.
Wipe off excessive grease evenly across the rod using absorbent cotton.

Fixing spring

Holder

Fixing screws Movable aperture holder
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3 Replacing the Fuses

In an event listed below, look through the window under the console to check if the main power fuseless
breaker is tripped, check the back of the scanning system frame if the fuseless breaker of the
evacuation system is tripped, and check if the fuses in the fuse holder in the evacuation system breaker
box are blown.

1) You cannot hear noise of the rotary pump operation while the operation program is starting up.
Check the RP (F1) fuse in the evacuation system breaker box.

2) Some status indicators in the evacuation system dialog box do not come on while the operation
program is starting up.
Check the VAC (F1) fuse.

3) The evacuation system READY status is not established after a prolonged time (40 minutes or
longer).
Check the DP (F2) and RP (F1) fuses.

4) Evacuation does not start (DP is not heated).
Check the DP (F2) fuse.

5) A sudden vacuum drop occurred during operation, and you cannot find misoperation.
Check the DP (F3) and RP (F2) fuses in the evacuation system breaker box.

6) The system stopped suddenly.
Check the main power fuseless breaker through the window under the console.

Note: • The OFF indicator comes on when the main power fuseless breaker trips.
• Every fuse can be removed by turning the holder counterclockwise.
• When a fuse blows, replace it with a fuse supplied.
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4 Maintenance of Vacuum Equipment

This section provides an outline.  See the corresponding instruction manuals for details.

4-1 Oil level check on the diffusion pump (DP)
The diffusion pump in the evacuation system requires periodic inspection.
The inspection cycle may be about once a year but may vary significantly depending on the
operating conditions.  During inspection, the oil will be replaced or added according to the
vacuum level and oil contamination.

4-2  Replacing the heater of the diffusion pump (DP)
The heater is the most essential part for offering the diffusion pump performance.
When the boiler is turned on, the temperature rises to about 200°C in 20 to 40 minutes and the
pump starts operating.  If a wire braking occurs, since the heat sensor (thermostat) of the DP
does not work, the system will stay at the evacuation of DP process.  The user will easily see if
the system has a failure.
An iron plate is placed under the DP for protecting the floor.  Remove the four screws at both ends
and draw out the iron plate.  This makes the work easier.

4-3 Supplying oil to the rotary pump (RP)
Check the color and amount of the oil from the oil level gauge on the side of the pump.
New pump oil is transparent.  As it is used, it gets thick and turns brown.
In this case, replace the oil soon.
Typical intervals of oil replacement are between six months and one year.
The manufacturer suggests a maintenance cycle.

4-4 Replacing the oil mist filter
You should drain the oil as necessary.  Under some operating conditions, the manufacturer
recommends you to replace the filter element every six months.

4-5 Inspecting the turbo molecular pump (TMP) (Optional)
TMPs with battery backup function require battery replacement about once a year.
Other TMPs require fan inspection about once a year.
The manufacturer recommends you to overhaul the pump every two or three years.

4-6 Ion pump (SIP) (ERA-8800FE)
This pump needs no maintenance work.  However, the manufacturer recommends you to
overhaul the controller every five years.

4-7 Cold cathode vacuum gauge (ERA-8800FE)
This device needs no daily maintenance, but should be cleaned as necessary.



64

5 Maintenance and Service

5-1 Warranty period
The warranty period is one year after acceptance of delivery.
If a failure for which Elionix is responsible occurs within this period, Elionix will replace or repair the
failed parts without charge.
After expiry of the warranty period, we will provide bona fide and reliable service.
Note that the customer will be charged for such service.

5-2 Shipment of service parts
When you are in urgent need of consumable or replacing parts, place an order using an order
sheet specifying an order number.  Parts will be shipped immediately except for special parts.
This manual contains a list of special parts including O rings.
Refer to it to ensure correct ordering.

5-3 Specific inspection service
When adjustment or inspection of the system is necessary as part of specific service including
annual contract-based maintenance, overhaul, and transfer or modification of the system, we will
check and inspect the function, performance, safety, and operation of the system in accordance
with the attached inspection result sheet.

Should you have any questions, contact Elionix.

For service, contact
ELIONIX CO., LTD.
Headquarters and plant 3-7-6, Motoyokoyamacho, Hachioji, Tokyo, 192-0063

Sales department Tel. 0426-26-0611
Manufacturing department Tel. 0426-26-0702
Service section Tel. 0426-26-0705

Osaka office 602, Dai5 Shinosaka Bldg., 3-12-15, Nishinakashima,
Yodogawa-ku, Osaka, 532-0011

Tel. 06-6306-4191
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1 Block Diagram
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2 Relationship between Beam Diameter and Current

 Vacc=30 kV　 WD=10 mm  J=0.1 mA/sr
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 Vacc=1 kV　 WD=4 mm  J=0.1 mA/sr
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3 TFE Emitter History Table

Customer:                          System:                    TIP No.:               (  /  )
Set value Value on the monitor SIPDay Total time

Fila-
ment

Sup-
pressor

Exter-
nal

Fila-
ment

Sup-
pressor

Exter-
nal

Emission
current Up Dn

Remarks

Manu-
facturer
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4 Parts List

4-1 Standard supplies

1. Ribbon apertures 2

2. Ribbon aperture case 1

3. Specimen blocks 24

4. Parts case 1

5. Tweezers 1

6. Phillips screwdriver (large) 1

7. Phillips screwdriver (medium) 1

8. Slotted screwdriver (large) 1

9. Six-precision screwdriver set 1

10. Ball screwdriver set 1

11. Conductive adhesive (Dotite) 1

12. Plastic cans 3

13. Metal polish (POL) 1 (in the case)

14. Burn-out preventive (Moresco Releaser) 1 (in the case)

15. Vacuum grease 1 (in the case)

16. Ratchet torque wrench 1

17. Hexagonal head holt (M12 × 40, for gate valve) 1

18. O ring (P6, for specimen exchange rod) 1

19. Reference specimen for cross-sectional calibration 1

20. Fuses, 250 V, 0.3 A 2

21. Fuses, 250 V, 0.5 A 2

22. Fuses, 250 V, 1 A 2

23. Fuses, 250 V, 2 A 2

24. Fuses, 250 V, 5 A 2

25. Fuses, 250 V, 6 A 2

26. Fuses, 250 V, 8 A 2

27. Fuses, 250 V, 10 A 2

28. Fuses, SGA, 10 A 2
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4-2 Components

No. Name Unit
PE- 101 Tungsten electron gun filaments 1 dozen

102 Tungsten electron gun filament leaf springs 1 pair
104 Electron gun wenelt cap 1
105 Wenelt cap removing tool 1

PA- 201 Wenelt cap shim 1
PE- 113 Deflection SUS pipe 1

114 Condenser aperture holder 1
115 Condenser aperture 1
116 Objective aperture holder 1
117 Objective aperture (φ0.2) 1
120 Scintillator chip φ10 mm 1

PA- 202 Photo-multiplier tube
(Balance adjustment of R647 is not included) 1

203 O rings (See the O ring list) −
204 DP thermal switch 1
205 DP heater 1
206 DP oil (Sand back 5) 125 cc
207 Airlock, φ10 mm 1
208 Fuses (1 A, 2 A, 5 A, 6 A, 7 A, 10 A, two each) 1 set

PE- 208 Specimen holder, φ10 × H15 1
209 Specimen holder, φ50 × H35 1
210 Specimen holder, φ125 × H15 1
211 Multi-specimen holder, φ170 1
213 φ46 airlock holder, φ10 × H15 1
214 φ70 flanged holder, φ10 × H15 1
216 Specimen blocks, φ10 mm 50
219 Specimen blocks, φ50 mm 5
220 φ10-mm tilt cut blocks, 45 degrees 10
221 φ10-mm tilt cut blocks, 60 degrees 10
222 φ10-mm tilt cut blocks, 70 degrees 10

PE- 309 Rotary pump oil (MR100) 1 liter
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4-3 General parts

No. Name Unit
PA- 301 Film, FP550B (10 exposures) 1

302 Film, FP300B (10 exposures) 1
303 Film, FP400B (10 exposures) 1
304 Film, Polaroid 331 1
305 Film, Neopan SS, 6 × 7, 120/220 1
306 Gold on Carbon test specimen, φ10 mm 1
307 Latex particles (1 µ), φ10 mm 1
308 Peak loupe
309 Spray, M-type 1
310 Printing paper 5 sets

PE- 224 Dotite (D-550, Silver) 20 g
225 Graphite paste 20 g
226 Golden target for coating, φ50 mm 1
227 Golden target for coating, φ150 mm 1
230 Thinner 100 cc
231 Plastic sanitary gloves 1 pkg.
232 Hygiene gauze 1 pkg.
233 Aluminum foil 1 pkg.

PE- 314 Rubber vacuum hose 1 m
315 Vacuum grease, Apiezon M 250 g
316 Vacuum grease, Apiezon L 250 g

PE- 501 Metal polish (Pikal care) 150 g
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4-4 X-ray analysis standards

No. Name Purity (%) Remarks Q’ty & Unit
PX- 501 AI  99.9 1 piece

502 Sb  99.9999 1 piece
503 Bi  99.9999 1 piece
504 B  99.99 1 piece
505 C  99.99 1 piece
506 Cr  99.99 1 piece
507 Co  99.99 1 piece
508 Cu  99.999 1 piece
509 F  99.99 LiF 1 piece
510 Ga  99.99 GaAS 1 piece
511 Ge  99.999 1 piece
512 Au  99.99 1 piece
513 Hf  99.99 1 piece
514 In  99.99 InAs 1 piece
515 Ir  99.9 1 piece
516 Fe  99.99 1 piece
517 LaB6  99.9 1 piece
518 Mg  99.9 1 piece
519 Mn  99.99 1 piece
520 Mo  99.999 1 piece
521 Ni  99.99 1 piece
522 Pd  99.999 1 piece
523 P  99.999 GaP 1 piece
524 Pt  99.9 1 piece
525 Rh  99.999 1 piece
526 Si  99.999 1 piece
527 Ag  99.999 1 piece
528 Ta  99.98 1 piece
529 Te  99.9999 1 piece
530 Sn  99.999 1 piece
531 Ti  99.9 1 piece
532 W  99.99 1 piece
533 V  99.99 1 piece
534 Zro2  99.9 1 piece
535 Zn  99.999 1 piece
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PX- 536 Zr  99.9 1 piece
537 Na2O  18.8 Glass-1 1 piece
538 MgO  99.99 Synthetic 1 piece
539 Al2O3  99.99 Synthetic 1 piece
540 SiO2  99.99 Synthetic 1 piece

K2O  19.0
541

CaO   9.20
Glass-2 1 piece

542 TiO2  99.99 Synthetic 1 piece
543 Cr2O3  99.9 Synthetic 1 piece
544 MnO  99.9 Synthetic 1 piece
545 Fe2O3  99.9 Natural 1 piece

MnO
546

Fe2O3
 99.99 Synthetic 1:1 1 piece

547 CoO  99.9 Synthetic 1 piece
548 NiO  99.9 Synthetic 1 piece
549 SrTiO3  99.99 Synthetic 1 piece
550 ZnO  12.99 Glass-3 1 piece

BaO  99.9
551

PbO  21.9
Glass-4 1 piece

552 PBS  99.9 1 piece
553 FeS  99.9 1 piece
554 NB  99.9 1 piece

Reference glass analysis data (Glass 1 to 4)

Specimen Glass-1 Glass-2 Glass-3 Glass-4
SiO2 66.3 66.1 61.4 46.3

Al2O3 0.02 0.02 2.07 0.23
Fe2O3 0.01 0.01 0.01 0.01
Na2O 18.8 0.08 18.3 7.72
K2O 0.05 19.0 0.05 0.08
CaO 9.10 9.20 0.10 0.10
MgO 5.40 5.40 5.10 0.10
B2O3 <0.01 <0.01 <0.01 <0.01
As2O5 <0.01 0.01 0.02 0.02
PbO <0.01 <0.01 <0.01 21.9
BaO <0.01 <0.01 <0.01 15.2
ZnO − − 12.9 8.25
Pt 0.0025 0.0025 0.0025 0.0025

★ All specimens are
stuffed into a pipe,
polished and carbon-
deposited.
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PURCHASABLE ACCESSORIES
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Photography unit

1 Overview

The photography unit for the ERA-8800 uses a super high-resolution flat face flying spot CRT, providing
good picture quality over the entire screen.
Also, a wide range of camera holders are available to meet your specific needs.

2 Specifications

CRT ..................................................Super high-resolution flying spot tube

Raster resolution .............................2000 lines max.

XY input ...........................................10 VP-P max.

Video input ......................................10 VP-P max.

Photo mode .....................................PICTURE, LINE, SPOT (X-ray image)

PHOTO SPEED ..............................40, 80, 160, 260 (sec/frame)

PHOTO DATA .................................Micron marker, magnification, numbering, date,
acceleration voltage, detector, electron optical column and
power supply data

Lens aperture ...................................5, 6, 8, 11, 16, 22, and 32

Camera and holders .......................See Table 4.

Photographic magnification .............Depending on film size (×0.5 to ×1.0)

3 Cautions on use and maintenance

The photographic conditions will vary depending on the holder and film.  Choose a holder and film
according to the purpose and application.  The conditions are configured at the factory and in most
cases, reconfiguration is unnecessary.  If you reconfigure the conditions, take the following steps.

(1) Take one picture as a trial .  When the contract and brightness are appropriate, you may proceed
to further photography.  If the stripes on the screen appear extremely bright or dark, readjust the
CRT unit by taking the following steps.

(2) Remove the front panel of the photography unit.  Adjust the 10-turn helipot dials for the contrast
and brightness.

(3) Using the left dial, adjust the darkest stripe in the photo taken in the TEST mode.
Each contract scale takes about 0.15 scales on the dial.

(4) Turn the contrast dial to adjust the color of the white stripe to the color of the paper around it.
Normally, this dial is fixed at 5.0.

(5) Now the adjustment is completed.
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Changing the scanning width

You have to change the scanning width of the photography unit depending on the film size.
Take the following step to remove the holder and use the switch inside.

1) Loosen the two screws fixing the camera holder.  Slide and remove the holder.

2) In the camera obscura, you will find a toggle switch at the left corner.
Turn this switch to the holder type you use.
(See the nameplate at the switch.)

3) This switch is set to PRH in most cases.  Note that the appropriate film size for this setting is
119 × 89 mm.  When you use a film roll, the XY scanning width is 60 mm × 40 mm, and the
magnification is ×0.5.

4) After turning the scanning width switch, check the lens aperture.  The aperture is preset to a
proper value according to the film sensitivity and scanning speed.  As a guideline, the most
common settings are sensitivity of ISO500 and scan speed of 40 seconds.  With these settings,
appropriate aperture is 8.  At a scan speed of 80 seconds, set the aperture to 11 or 16.
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4 Camera holder

1) Polaroid Land film holder (PRH-4)

Overview: The most common holder.  The screen size is 118 mm × 89 mm.
Applicable film includes Fuji Instant FP-3000B and FP-5000B.

Instruction

1. As shown in the photo on the left, open the lid by
moving both lock levers outward at the same time.
Load film, from the right side first, then press it
against the pack.
At this step, hold the pack on both ends.
Close the back lid, press on the PUSH mark to
lock the lid.  Check that you can see the end of
the light-shielding sheet.

2. Pull the light-shielding sheet straight in the
direction of the arrow.
Then a white tab appears.  Now you are ready to
take pictures.
Do not pull out the white tab before exposure.

3. When the image adjustment completes, pull the
drawing cover toward the front, until a release
mark appears.
Press the PHOTO switch to complete.

4. After taking a picture, pull the while tab.
Development will complete in about one minute.
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2) Polaroid pack film holder (PRH-2)

Overview: This holder has almost the same features as the Land holder except the screen
size.  The screen size is 95 mm × 73 mm.
Applicable film includes Polaroid 667 and Fuji Instant FP-100 and FP-400B.
One pack contains 10 exposures.  Coating is not necessary.

Instruction

1. Open the lid.  Holding both ends of the film pack, press it into the pack.
Close and firmly lock the lid.  Check that you can see the end of the light-shielding sheet.

2. Pull the black light-shielding sheet straight.  Then a white tab appears.
Now you are ready to take pictures.  Do not pull out the white tab before exposure.

3. When the image adjustment completes, pull the drawing cover toward the front, until a
release mark appears.
Press the PHOTO switch to complete.

4. After taking a picture, pull the while tab.  Development will complete in about one minute.
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